
  
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

July, the month we kick into the full force of summer. With our 
family BBQ’s, swim parties, and iced cold drinks with friends.  It’s 
the halfway point in the calendar year, where the days are long and 
we hope for the gentle breezes to cool us off in the evenings. 

 

In IAAP language, July is the beginning.  The beginning of a new 
term, a new theme from International is announced, and the slates 
are swept fresh for each of us to strive for excellence once again. 

 

This year’s theme is: “Making the Leap to Remarkable – Step Up, 
Think Big, and Lead the Way.” 

 

President’s Message 
By Kathi Cohen 
 

WWhhaatt  ddooeess  tthhiiss  mmeeaann  ttoo  yyoouu  aanndd  hhooww  wwiillll  yyoouu  iinnccoorrppoorraattee  tthhiiss  iinnttoo  yyoouurr  ggooaallss  ffoorr  tthhiiss  tteerrmm??  
I would love to hear your thoughts!  Whether it’s volunteering, attending chapter meetings, 
getting CAP certified or achieving Member of Excellence, I am optimistic that each of us can 
indeed step up, think big, and lead the way! 

 

HHooww  ccaann  wwee,,  tthhee  SSaann  JJoossee  cchhaapptteerr,,  bbeeccoommee  rreemmaarrkkaabbllee  tthhiiss  yyeeaarr??  One way of measuring 
excellence is through the Pathways to Excellence program.  Your incoming 2011-2012 BOD 
members have been diligently meeting to prepare for this term and each of us is committed to 
becoming a Chapter of Excellence.  Ask any one of us how you can help us with this goal; we 
would love the assistance. 

 

HHooww  ccaann  yyoouu,,  aass  aa  mmeemmbbeerr  ooff  tthhee  SSaann  JJoossee  cchhaapptteerr,,  bbeeccoommee  rreemmaarrkkaabbllee  tthhiiss  yyeeaarr??  Again, 
IAAP offers the Member of Excellence program and I encourage you to set this as your 2011-
2012 goal.  Achieving a minimum of 8 out of 11 criteria might at first appear daunting, but with 
planning and a bit of effort, I am confident you will succeed.  At our upcoming chapter meetings 
we will be handing out mini wallet cards with all the requirements to help you keep these in the 
front of your mind.  Let THIS be the year you go for it! 
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Perhaps you missed all the excitement this past year about getting certified.  Not to worry, the 
new CAP guidelines are out and it’s perfect timing for the November exam.  The San Jose 
chapter would love to start a new study group and there’s even a budget line item for purchasing 
the new textbooks.  With a few recommendations from members, who recently passed, these 
groups can be self-guided and highly motivational, not to mention all the great friendships you 
will create.  Look for a sign-up sheet at the registration table or contact a BOD member if you are 
interested. 

SSoo,,  lleett’’ss  aallll  SStteepp  UUpp,,  TThhiinnkk  BBiigg  aanndd  LLeeaadd  tthhee  WWaayy  ttoo  bbeeccoommiinngg  RReemmaarrkkaabbllee!!  

Hi ECC Members: 
  
As I am the Chair of the Certification Committee, I thought I should remind 
you of a deadline that is coming up soon... 
  
But first let me congratulate Erica Gutierrez for passing the CAP Exam on 
her first try!  
  
If you wish to take the IAAP CAP Exam this coming November, you must 
register (by completing/submitting the Application) by August 15 2011...so 
don't wait, do it soon. We all know how quickly time gets away from us! 
  
I refer you the site that will provide information about the CAP Exam: 
www.iaap-hq.org 
Certification button 
You'll find 'changes' and current news about the CAP Exam, as well as the 
Application form. Note that you will need to provide information about your 
administrative work experience and education (Employer's letter/form; 
transcrips).  
  
I understand that Erica is planning on running a study group for the CAP 
Exam -- I haven't touched base with Erica yet; however, I'm sure she will 
provide further news on this front... 
  
Thanks for your attention, 
Margaret J Nakayama 

Certification Committee Updates 
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Chapter Meeting:  Wednesday, July, 13, 2011, 5:30pm to 
8:00pm 

Happy 65th Birthday San Jose IAAP!!! 
  

Get Ready to LAUGH… we 
will be having some fun this 

month! 
Sandy Stec will be 

entertaining us. She is a local 
comedian that will be sure to 
have you in stitches.  With the 
gift of gab and a passion for 
people, it’s no wonder Sandy 

Stec has taken the 
entertainment world by storm. 

Currently an on-air 
personality for Mix 106.5 in 

San Jose, 
Sandy has hosted her own 

midday radio show for over 9 
years.   

Meal choices include a vegetarian choice: Farfalle Pasta Primavera meat selection: 
Baked Salmon Filet, both entrees served with House Salad, Rolls with Butter, 

Chef’s selection Dessert, Coffee, & Tea. 
 
Meal prices are $25/member and 
$30/guest.  Meeting-Only pricing is 
$10/member and $15/guest.  Please note this 
pricing structure has been in effect since 
February. 
 

Network Meeting Center @Techmart
5201 Great America Parkway 
Santa Clara, CA 95054 
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Get organized: 7 ways to better sort, store, and 
search your email 
A cluttered and unorganized mailbox can make it difficult to find the email you need. This messy situation 

can be remedied. Microsoft Outlook offers great tools that help you sort your email and organize your 

messages in meaningful, easy-to-control ways. Outlook can even help increase your efficiency and 

productivity. Whether you're using Outlook 2010, Outlook 2007 or Outlook 2003, you'll be better able to stay 

on top of your mail. 

Not using Outlook email at all? Perhaps you're using Outlook Express, or maybe you’re using Windows Live 

Mail or Windows Live Hotmail. These programs offer some features similar to those described here for 

Outlook, but they don’t offer the same breadth of tools for email management. Use the Microsoft Office 

Outlook Hotmail Connector to add your Hotmail account to Outlook, and then you can use these tips to also 

organize your Hotmail. Or read about the Hotmail features that can help you organize information in your 

Hotmail system. For instance, you can combine mail from your other email accounts, like Gmail and Yahoo! 

Mail, so that you can receive, read, and respond to all your email in one place. 

You can use one or more of the tools covered in this article to help shrink your Inbox and to make it easier to 

find the information you need. 

1. Sort messages quickly 

Outlook 2010 has a great new feature for organizing messages by date and arranging them by 

Conversation. Using this feature, messages that share the same subject appear as Conversations that can 

be viewed and expanded or collapsed by clicking the icon to the left of the Subject line. The messages 

within each Conversation are sorted with the newest message on top. When a new message is received, the 

entire Conversation moves to the top of your message list, helping to make tracking email threads a snap. 

To turn on Conversations, on the View tab, in the Conversations group, select the Show as 

Conversations check box. You can reduce the size of a conversation with the Clean Up feature, which 

deletes duplicate messages in the Conversation. On the Home tab, in the Delete group, click Clean Up, and 

then click Clean Up Conversation. 

In all versions of Outlook, you can find messages in mailbox folders more quickly by changing how they're 

sorted in your email folders. For example, you can arrange your email by date, sender, file size, or level of 

importance. 

 

Office Tips and Tricks 
by Microsoft at Work 
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2. Group similar messages in folders 

By creating new mail folders, you can group messages related to each other. For example, you can group 

messages by topic, project, contact, or other categories that make sense to you. You can even create a 

folder for all the messages from your manager or one that include tasks that you have to complete. 

 To create a new folder in Outlook 2010, on the Folder tab, in the New group, click New Folder.  

 To create a new folder in Outlook 2007 or in Outlook 2003, on the File menu, point to New and 

then click Folder.  
 

3. Create Search Folders to find messages fast 

Search Folders are a quick and convenient way to look at predefined collections of email messages. They 

don't actually store any messages themselves but, instead, are virtual folders that offer a view of all the 

messages stored in your mailbox depending on the attributes you've defined. Outlook provides default 

Search Folders—such as Unread Mail—but you can also create your own. For instance, you can use 

Search Folders to help you find all the information related to a particular project, an important client, or an 

upcoming conference.  

 To create a Search Folder in Outlook 2010, in Mail, on the Folder tab, in the New group, click New 

Search Folder.  

 To create a Search Folder in Outlook 2007 or Outlook 2003, in Mail, on the File menu, point to 

New, and then click Search Folder.  

In all versions of Outlook, specify whether you want to use a predefined Search Folder or to create your own 

custom folder, and then follow the instructions on the screen. 

 
4. Route mail efficiently using mailbox rules 

By creating rules for Outlook, you can automatically perform actions on both incoming and outgoing 

messages based on criteria you establish. For instance, you can automatically forward to your manager all 

messages sent by a certain person as soon as they arrive, assign the category Sales to all messages you 

send that have the word "sales" in the Subject line, and more. Routing mail efficiently not only organizes 

your mail for you—but also frees up your time from performing routing tasks. 

 
5. Reduce unwanted email with junk filters 

Keep distracting and unwanted messages out of your Inbox by using Outlook Junk Email filters. These filters 

send email flagged as junk to a separate mail folder in your Mailbox. You can review the contents of this 

folder to ensure that no legitimate messages have been sent there, and if they have, you can adjust the filter 

to avoid flagging such messages in the future. 

 
6. Assign a color category 

Assign a color category to a group of interrelated email messages and to other items in Outlook, such as 

notes, contacts, and appointments, so that you can easily identify and organize them. For example, keep 
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track of all the messages, meetings, and contacts for the Morris project by creating a category named Morris 

project and assigning items to it.  

 
7. Flag for follow up 

You can use the Flag for Follow Up feature to flag email messages and tasks to help categorize them or to 

mark them for action. Flags can remind you to follow up on an issue, indicate a request for someone else, or 

set a reminder for a message or contact. They can also make organizing your mail folders a breeze, 

because you know exactly what to do—and when to do it. Note that when you create a task and set a due 

date, the task is automatically flagged so that you don’t let that due date slip past you. 

What can the IAAP San Jose Chapter do for you?  

Think about what your membership means to you.  What do you want to accomplish?  
Are you hoping to further your career?  Learn new skills?  Are you looking to build 
professional relationships?  Establish power partners?  Develop leadership skills? 
 
Building your professional networks, finding career advice and uncovering new industry 
resources are just a few of the things the San Jose Chapter has to offer its members.  .   
 
Identify your objectives for participating in meetings, events, and other IAAP activities to 
ensure your membership in the San Jose Chapter is a success.  Members with clear 
objectives achieve what they’re seeking because they know what they’re looking for. 

Just being in the room, exchanging names, and business cards won’t get you specific 
career advice or develop professional relationships.  Time is required to build meaningful 
relationships.  Committees you work on, events you help plan, programs you help 
coordinate by volunteering your time – that’s where you really develop working 
relationships with other members.  In doing so, you will also learn more about the 
resources within IAAP and the San Jose Chapter; and your new contacts may know of 
additional resources relevant to your objectives. 

Being a part of IAAP creates more opportunity for you, your career development, and 
advancement.  The true impact comes from your participation.  By helping IAAP achieve 
its mission, you immediately see the fruits of your labor.  So get involved.  Join a 
committee.  Help plan an upcoming event.  Help out at chapter meetings.  Meet people 
and achieve your objectives.  The more you engage, the more you receive.  Be an 
ACTIVE member! 

By Vicky Lara 
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Kathi Cohen, CPS/CAP 
President 
408-892-9558 

kathicohen@hotmail.com 

 

Ronni Handley, CPS/CAP 
Treasurer 
408-568-3380 

Ronni.handley@gmail.com 

 

Vicky Lara, CPS 
1st VP Membership 
408-218-8584 

Vicky.Lara@berryessa.k12.ca.us 

Renee Castro   
2nd VP Programs 
408-410-3191 

rcastro@opsource.net 

 

Karen Meyer 
Corresponding Secretary 
408-460-3160 

karen_meyer@symantec.com.co
m 

 

Rob James 
Recording Secretary 
(650) 470-2892 

rrjames25@gmail.com 

CA Division 

http://www.iaap-ca.org/  

 

 

International Headquarters 

http://www.iaap-hq.org/  

 

 

Retirement Trust 
Foundation 

http://www.iaap-rtf.org/  

2011-2012 BOD Contacts & Websites 
The Board of Directors would love to hear from you!  Here’s our contact 
information: 


